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Erste Schritte mit Robocode

1 Bevor du beginnst

e Stelle sicher, dass Du Java und Robocode wie im Dokument vom ersten Tag
Robocode auf Windows installieren.docx beschrieben, installiert hast.

2 Starte Robocode und verwende den Code-Editor
e Starte jetzt Robocode wie es im Dokument vom ersten Tag,
Robocode auf Windows installieren.docx, beschrieben ist.
e Jetzt wahle vom Robot Menu den Source Editor (Quellencode Editor) aus, um den
Java Editor zu starten. Auch das ist im Dokument von gestern beschrieben.

Bl robot Editor [u] X
File Edit View Compiler Window Help

3 Erstelle Deinen ersten Roboter
* Im Robot Editor (Source Editor) wéhle File -> New -> JuniorRobot

MR Robot Editor
File Edit View Compiler Window Help

Mew Robot Strg+M

Open Strg+0 JuniorRobot dl

Extract downloaded robot for editing Java File E:—Umschahﬁl\l
Save Strg+5

Save As Strg+Umschalt+5

Exit

e Wir nennen den Roboter Dayl

New Robot X

Enter the name of your new robot.

Example: MyFirstRobot

Note that the name cannot be empty or contain spaces.
Day1

| 0K I Cancel
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Wenn Du nach einem Namen fiir ein Package gefragt wirst, nenne das Package

HomeChallenge. Ein Package ist eine Sammlung in Java in der wir alle Roboter
sammeln und abspeichern.

Package name for Day1 X ‘
Enter a short package name for your new robot and without spaces (lower-case letters are prefered).
Your initials will work well here.

Your robot will be put into this package to avoid name conflict with other robots.

The package name is used to identify your robot(s) in the game, especially if you

want to let your robot(s) participate in ¢ titi like e.g. Rob !l

Hence, you should enter the same package name for all of your robots.
Note that the package name cannot be empty or contain spaces,
HomeChallenge

Cancel

e Speichere Deinen Roboter mit dem File > Save Menu
m Rabot Editor
File Edit View Compiler Window Help

MNew ?
Open Strg+0

Extract downloaded robot for editing

Save Strg+5

Save As Strg+Umschalt+5 '
Exit

AINS II o 4]

e und sage Ja um einen neuen Ordner (Directory) zu erzeugen.

Create Directory X

Your robot should be saved in the directorny: Chrebocode\robots\HomeChallengeh,
This directory does not exist, would you like to create it?

Mein Abbrechen
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E Speichern bt

Speichern in: HomeChallenge w ? o .

23

Zuletzt verw...

Desktop

\ﬂ%

Dokumente

L

Dieser PC
y

Dateityp: Robots w Abbrechen

e lassen uns sofort den Roboter bauen, indem wir ihn kompilieren. Kompilieren, compile
im Englischen, Giberprift zunachst, ob der Computer alle Anweisungen versteht, und
zum anderen wird der Java-Code in etwas umgewandelt, das der Computer ausfiihren
kann.

Klicke auf Compiler > Compile, und vergewissere Dich, dass der Code
erfolgreich kompiliert wird.

Bl Compiled successfully. x
Edit

Compiling...
[parsing
[reading
[reading
[reading
[reading
[reading

[reading e/ robotinterfaces/peer/IBasicRobo
[reading tinterfac | cEvents

[writing

enerated]
safully.
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Dazu sollte das Ausgabe Fenster am Schluss die Meldung ‘Compiled successfully’
zeigen.

Wenn Du hier irgendwelche Probleme hast; wenn Du Fehlermeldungen siehst, dann musst Du
versehentlich etwas in den Editor eingegeben haben. Versuch dies zu beheben oder wenn Du
den Fehler nicht findest machen Sie einen neuen Roboter von Grund auf neu; dh. starte den
Abschnitt einfach nochmal von vorne.

Deine Arbeit wird einfacher, wenn Du das Quellencode (Source Editor) Fenster immer
offenhéltst wahrend Du mit dem Hauptprogramm weiterarbeitest.

4 Deine erste Schlacht

e Gehe nun zum schwarzen Robocode-Hauptfenster zurlick, wie schon vorhergesagt
lassen wir den Quellen Code Editor offen

 robocode,Used men 17 of 494 e ~ s x
Battle R elp

e \WihleBattle > New

e Wahle HomeChallenge aus der linken Spalte (Packages) aus, wdhle dann Dayl
aus der mittleren Robots Spalte aus und klicke auf den Add Knopf um diesen

I Mew Battie X
Robots  Rules
Select robots for the battie
Available Robots Selected Robots
Packages Robots v1*
ar < Add > Day1
(al) Target
Add A] ->
sample
sampleex
samplesentry
sampleteam
No package)
<-Remove
Press Chil+R to refresh  Resmows M
HomeChallenge.Day1 (development version)
file:|C: frobocodefrobots fHomeChallenge/Day1 class
Next Start Battle gancel
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Roboter zur Liste der ausgewdhlten Roboter (Selected Robots) auf der rechten Seite
des Fensters hinzuzufiigen. Dann wahle aus dem sample (Beispiel) Paket den Roboter
Target (Ziel) aus und flige auch den zur Liste der ausgewahlten Roboter hinzu.

Dricke jetzt den Next Knopf am unteren Rand des Fensters.

Andern im nichsten Schirm die Anzahl der Runden (Rounds) auf 1 und klicke den
Start Battle Knopf.

E New Battle
Robots Rules

Battlefield Size
Number of Rounds: 1

Predefined Sizes
Gun Cooling Rate: 0.1

400x400
Inactivity Time: 450
Sentry Border Size | 100
600x400
Hide Enemy Names: []
600x600
B00x600
800 x 600 800x800
1000x800
1000x1000
1200x1200

2000x2000

5000x5000
v

Restore Defauks

Back Cancel

Start Battle |

Du siehst jetzt eine seltsame und sehr langweilige Schlacht:

Dein Roboter bewegt sich vorwarts und riickwarts und schwingt sein Kanonenrohr am
Ende jeder seiner Bewegungen rund herum

Wenn das Geschiitz auf den Feind zeigt, wird es schiessen, aber das Geschiitz bewegt
sich so schnell, dass es wahrscheinlich am Feind vorbeischwenkt, bevor der Schuss
abgefeuert wird und das Ziel wird vollstandig verfehlt.

Jedes Mal, wenn Dein Roboter schiesst verliert er eine Einheit 1 Energie. Wenn du es
schaffst, den Feind zu treffen, bekommst du etwas Energie zuriick. Aber in dieser
Schlacht verlieren wir nur Energie

Jeder Roboter, auch wenn er sich nicht bewegt, beginnt Energie zu verlieren. Das heisst
auch unser Ziel (Target) Roboter verliert Energie, und wird irgendwann zerstért. Man
kann diese Energieeinheiten in den Einstellungen fir ein Speil definieren.

Am Ende des Spiels erhaltst Du Sie eine Zusammenfassung, wer gewonnen hat und wo Du
Punkte erzielt hast.

m Results for 1 round X
Rank Robot Name Total Score  Survival Surv Bonus Bullet Dmg Bullet Bonus Ram Dmg * 2 Ram Bonus | 1sts | 2nds | 3rds
Ist HomeChallenge.Da... | 176(100%) | 50 | 10 | 9 | 19 0 | o |t]ofo
2nd |sample. Target 0(0%) 0 0 0 0 . 0 0 0|1 0
Save (8]3
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Unser Roboter lduft nicht sehr gut, auch nicht gegen ein Ziel, das sich nicht viel bewegt und nicht
zurlickschiesst. Das wollen wir nun @andern!

Wir werden jeden Tag neue Schlachten ausfiihren, erinnere Dich wie man
eine Schlacht (Battle) startet!
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5 Erste Verbesserung

Lassen Sie uns unsere run () - Method dndern. Eine 'Method' ist ein englischer Begriff. Zu
Deutsch verwendet man den Begriff Methode oder manchmal auch Funktion. In Java nennt man
eine Method, ein Stiick Code, der zusammengehoért und dem man einen Namen gibt, den der
Computer ausfiihren kann. In Robocode bringt eine Methode den Roboter dazu, etwas zu tun.
Es gibt verschiedene Arten von Methoden, die Dein Roboter zu verschiedenen Zeiten ausfiihren
kann, aber im Moment werden wir uns auf die run () - Methode konzentrieren. Die run () -
Methode wird zu Beginn jedes Runde ausgefiihrt.

Robocode verwendet Runden (im Original turns), gemessen in Ticks, so wie eine Uhr tickt, um
jeden Roboter Zeit zu geben, etwas zu tun. Ein Tick ist eine sehr kurze Zeit, so wird es fir Dich
aussehen, wie die Roboter immer etwas tun wiirde. Man kann sich einen turn, oder Runde, so
vorstellen, dass man sagt nun bist Du dran fir eine bestimmte Anzahl ticks, nun Du, nun Du.
Diese Runden stellen sicher, das alle Beteiligten immer wieder Zeit erhalten etwas zu machen.

Die run () - Methode liegt zwischen den Zeilen 15 und 29 im Roboter-Editor. Die aktuelle
run () - Methode flihrt ein paar Dinge aus:

e Essetzt die Farbe des Chassis, Kanone, Radar, Kugel und Dreh-Bogen Farbe auf orange,
blau, weiss, gelb und schwarz.

e Der Roboter geht dann in eine Endlosschleife, (while (true)) in der Schleife bewegt
sich der Roboter 100 Pixel vorwarts (ein Pixel ist 1 Punkt auf einem Computer-
Bildschirm), dreht die Kanone nach rechts fiir 360 Grad (360 Grad ist ein voller Kreis),
fahrt rickwarts fiir 100 Pixel und dreht die Kanone nochmals fiir 360 Grad nach rechts.
Es wird dies fur immer und immer und immer tun (oder bis das Spiel endet).

Hier der entsprechende Code aus dem Editor
while (true) {

// Replace the next 4 lines with any behavior you would like
// ersetzte die nichsten 4 Zeilen mit Deinen Aktionen
ahead (100) ;

turnGunRight (360) ;

back (100) ;

turnGunRight (360) ;

Im Beispiel Code, der von der Programmierumgebung gezeigt wird, sind alle Kommentare in
Englisch. Wir fiigen, wenn moglich eine markierte deutsche Ubersetzung hinzu und werden
die englische Version aber nicht I16schen, damit Du Dich im Code wie vom System prasentiert
zurechtfindest.

Was wollen wir also andern?

e Wir missen die Farben des Roboters nicht einstellen. Also I6schen wir das jetzt einfach.
Falls Ihr spater die Farben des Roboters andern wollt findet Ihr auf unsere Website
unter Projekte —> Code Stiicke (http://swisscoderdojo.org/de/code-snippets) eine
Anleitung wie man das macht.
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e  Wir brauchen die Schleife nicht, da die run()- Methode ohnehin zu Beginn jeder Runde
aufgerufen wird.

e Sich rlickwarts und vorwarts zu bewegen, ist im Moment sinnlos. Niemand schiesst auf
uns, also lasst uns einfach stillsitzen.

e Unsere Kanone bewegt sich zu schnell. Also, als wir den Feind entdeckt haben und eine
Kugel schieRen, ist das Geschiitz an dem Feind vorbeigefegt und wir treffen nicht.

Andern wir also unsere run () - Methode, dass sie wie folgt aussieht.:
public void run() {
turnGunRight (1) ;

}

Wir bewegen die Waffe um 1 Grad nach rechts. Dies wird die Waffe langsam bewegen, und
wenn wir einen Feind entdecken, wird es uns viel Zeit geben, einen oder mehrere Schisse zu
machen!

Lésche auch den gesamten Code innerhalb der OnHitWall () — und onHitByBullet () -
Methoden. Wir bewegen uns nicht, und niemand schiesst auf uns, also brauchen wir diesen
Code nicht. Die beiden Methoden sehen nun so aus:

public void onHitByBullet() {
// Replace the next line with any behavior you would like
// Ersetze die nichste Zeile mit Deinen Aktionen

}
public void onHitWall() {

// Replace the next line with any behavior you would like
// Ersetze die nichste Zeile mit Deinen Aktionen

Sehen wir uns also an, wie gut dieser neue Roboter funktioniert:

1. Speichern Deinen Roboter, indem Du auf File > Save klickst (oder kurz Strg+S
driicken).

2. Kompiliere Deinen Roboter, indem Du Compiler > Compile wahlst

3. Gehe zu deinem Robocode-Hauptfenster und beginne einen neuen Kampf mit deinem

Dayl-Roboter und einem Target-Roboter. Es sollte alles bereits eingerichtet
sein, aber wenn nicht, kannst Du den Anweisungen von oben folgen.

Hurra! Unser Roboter hat es diesmal viel besser gemacht. Aber es bleibt heute noch genug Zeit,
um eine weiter kleine Verbesserung vorzunehmen...
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6 Noch eine kleine Verbesserung

Das Hauptproblem ist jetzt, dass wir nur auf den Feind schiessen, wenn unsere Kanone auf ihn
zeigt, aber unsere Waffe dreht sich weiter. Ware es nicht grossartig, wenn wir unsere Waffe auf
den Feind gerichtet halten, sobald wir sie gefunden haben? Einfach!

Zu Beginn jeder Runde, wenn die run () Methode ausgefiihrt wird, wird das Geschiitz um

1 Grad nach rechts verschoben. Sobald wir also den Feind in unseren Scannern haben, sollten
wir der Waffe sagen, dass sie sich um 1 Grad nach links, also zurtick wo wir auch den Feind
gesehen haben, bewegen soll. Dadurch wird die Wirkung der Run () Methode aufgehoben.
Wenn sich der Feind weiterbewegt und unseren Scanner verldsst, schwingt das Geschlitz weiter
im Uhrzeigersinn.

Kehre nun zum Roboter-Editor zurtick.

Fir diese Anderung miissen wir uns die onScannedRobot () - Methode ansehen. Diese
Methode sollte direkt unter der run () - Methode in Zeile 21 liegen. Die
onScannedRobot () - Methode wird ausgefiihrt (oder aufgerufen), wenn Dein Roboter
einen anderen Roboter scannt (oder sieht). Im Moment hat die onScannedRobot () -
Methode nur einen Kommentar und einen Befehl.

// Replace the next line with any behavior you would like
// Ersetze die nachste Zeile mit Deinen Aktionen
fire(1l);

Ein Kommentar beginnt mit //, also zwei Mal unmittelbar hintereinander der vorwarts
Schragstrich (forward slash) und ihr konnt alles, was ihr wollt danach schreiben. Der Computer
ignoriert den Rest der Zeile. Kommentare konnt ihr verwenden, um eigene Notizen zu
schreiben. Diese Notizen helfen Dir Dich zu erinnern, was der Code bewirkt. Ihr kdnnt das
Kommentar Zeichen sogar vor einen Befehl stellen und der Computer ignoriert den Befehl.

Der Befehl in der onScannedRobot () - Methodeist £ire (1) ; . Dieser feuert das
Geschiitz mit einer Starke von 1 ab. Du kannst das Geschiitz mit jeder Starke von 0,1 bis 3 in
Schritten von 0,1 abfeuern. Je harter Du schiesst, dh je grosser die Zahl, desto mehr Schaden
wirst Du anrichten, aber desto mehr Energie verliert Dein Roboter damit.

Flgen wir nun einen weiteren Befehl zur onScannedRobot () - Methode hinzu, die Zeile die
wir mit einem Kommentar versehen haben ( // <<<< Neu ):
public void onScannedRobot() ({
// Replace the next line with any behavior you would like
// Ersetze die nichste Zeile mit Deinen Aktionen

fire(1l);
turnGunLeft (1) ; // <<<< Neu

Die neue Methode wird das Geschiitz um 1 Grad nach links drehen, wodurch die Drehung der
Kanone, die in der run () - Methode nach rechts gedreht wird, aufgehoben wird. Beachte
auch, dass der Befehl mit einem ;’ (Semikolon oder Strichpunkt) endet. In Java endet jeder
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Befehl mit einem ;. Das ‘;’ sagt dem Computer, dass wir das Ende eines Befehls erreicht haben.
Es ist das gleiche wie Punkt am Ende eines Satzes. Der Punkt bedeutet, dass wir das Ende dieses
Satzes erreicht haben.

Jetzt speichere und kompiliere den Code wieder und starte eine neue Schlacht mit einem
Target und einem Day1 Roboter.

Erfolg! Du hast jetzt nun einen ziemlich effizienten Roboter, um einen Feind zu bekdmpfen, der
weder zurlickschiesst und noch sich sehr viel bewegt.

In der nachsten Lektion werden wir die Dinge etwas schwieriger machen.

7 Bis zum nachsten Mal
Hier sind einige Dinge, die Du vor unserer nachsten Sitzung lesen kannst:

http://robowiki.net/wiki/Robocode/My First Robot

Falls diese Website nicht reagiert konnt ihr einen dieser alternativen Link benutzen,
https://web.archive.org/web/20190826172033/http://robowiki.net/wiki/Robocode/My First R
obot, oder http://robowiki.duckdns.org/index.php/Main Page.

Der Obige Link enthalt einige weitere Informationen Utber das, was wir getan haben, und kann
Dir einige weitere Ideen geben, mit denen Du bis zur ndchsten Lektion herumspielen kannst.
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